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Introduction 

InScribe is a HIPAA-compliant typing application designed by transcriptionists for transcriptionists. It is a single, integrated 

application designed for heads-down production. With InScribe, everything is easily accessible — demographics, referring 

physician information, AutoText (word expander), spell check — all the tools needed to easily and quickly complete a 

high-quality document. 

Over the years, InScribe has grown and developed into a tool that helps its users consistently produce a higher number of 

lines than they would with traditional word processing applications. With InScribe, far less time will be spent researching 

or printing transcriptions, cover letters, and envelopes. Altogether, InScribe’s features allow users to be in production 

mode the majority of the time, increasing their productivity and efficiency. 

Additional new features and functionality introduced in InScribe 7 will be added to this user 
guide in the coming months. Please check back for an updated version soon. 

Highlights of InScribe include: 
Demographics 

Demographic information (patient name, MRN, etc.) in many cases is imported using an interface with the hospital. When 

you input the unique patient MRN or name, the system automatically searches for and presents you with matches. When 

the patient is selected, the system displays the corresponding appointment dates and imports all available demographics. 

Referring Clinician Information 

Primary care physicians, attending physicians, and other individuals can be designated to receive copies of a transcription 

electronically, via auto-fax, or by standard mail. You have access to an online database of referring clinicians to easily 

assign recipients per the dictation. Less time is wasted researching names and addresses.  

Body of Document 

The body of an InScribe document is built from templates (dictation or document), AutoText (word expander), and free-

hand typing. Document templates automatically load into the body of the transcription based on a combination of author, 

document type, and location. Dictation templates are retrieved from the server based on what an author dictates (e.g., 

“normal left wrist”). No time is wasted finding the proper template. 

Authorizations 

When transcriptions require approval by more than one clinician, InScribe’s online database of dictating clinicians makes it 

easy for you to select the appropriate clinician and assign the order of authorization.  

A Note on Hot Keys 

The hotkeys displayed in red in this user guide are the default hotkeys 

assigned when InScribe is first installed.  They are known as the 

“Modified Shortcuts.” There are two other configurations available called 

“Classic Shortcuts” and “ASR Enhanced Shortcuts.”  
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Requirements 

For eScription One InScribe software to work properly within a Windows environment, your system must meet the 

following software and hardware requirements:  

(Macintosh computers are NOT supported by eScription One.) 

Minimum Requirements: 

– Operating System: Windows 10 

Note: eScription One does not support any versions of Windows prior to Windows 10. Please upgrade Windows before 

calling. 

– RAM: 4 GB 

– Processor: 1 GHz or faster (64-bit Architecture) 

– Hard Drive Free Space: 1 GB 

– .NET Framework: 6 or higher 

– Sound Card with Speakers (or Stereo Headphones) 

– Monitor Resolution: A monitor capable of displaying a resolution of 1366 x 768 pixels 

– Internet Connection: High Speed Cable or DSL 

– Internet Bandwidth: 3 Mbps download; 1 Mbps upload or greater 

– Communicates over port 443 to https://transcription.escription-one.com using TLS 1.2 

Recommended Requirements: 

– Operating System: Windows 10 or higher 

– RAM: 8 GB or more 

– Processor: 1 GHz or faster (64-bit Architecture) 

– Hard Drive Free Space: 2 GB or more 

– .NET Framework: 6 or higher 

– Sound Card with Speakers (or Stereo Headphones) 

– Monitor Resolution: A monitor capable of displaying a resolution of 1366 x 768 pixels or higher 

– Internet Connection: High Speed Cable or DSL 

– Internet Bandwidth: 3 Mbps download; 1 Mbps upload or greater 

– Communicates over port 443 to https://transcription.escription-one.com using TLS 1.2 
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Installing InScribe 

Note: Users working on a domain network may need administrator privileges to install eScription One or any other 

programs. 

Download the InScribe application from the eScription One Software page here: https://www.escription-

one.com/Software/InScribe. Click the Install Link for the version of InScribe you would like to install. 

Note: Contact the transcription company manager to verify which version to install. 

– Select “Open” or “Run”. 

– Select “Next” on the “Welcome to InScribe 7 Setup Wizard” screen.  

– Check the “I accept the terms of the license agreement” box on the End-User License agreement screen and then click 

“Next.” 

– Click “Next” on the “Installation Scope” screen. 

– Select an installation folder. eScription One recommends using the default location. Click “Next” to advance to the next 

window.  

– Click “Install” to begin the installation process on the “Ready to Install” screen. 

– The installation is now complete. On the “Completed Setup” screen, you have the options of “Launch InScribe Now,” 

“View Release Notes,” or “View Training Materials.” Select any option(s) if desired and then click “Finish.” The “View 

Release Notes” provides a summary of changes in prior versions and recently added bug fixes, features, or 

improvements. 

Using InScribe 

Note: Obtain a username and password from the transcription company's system administrator prior to logging into 

InScribe. 

Click the shortcut created on your desktop to start the InScribe program. 

 

An additional shortcut is located on the “Start” Menu. To access it, click the “Windows” icon, then scroll to the “InScribe 7” 

folder. Expand the folder and click “InScribe 7”.  

 

 

https://www.escription-one.com/Software/InScribe
https://www.escription-one.com/Software/InScribe
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Select a Region 

The first user who logs in to a new InScribe installation 

will be prompted to select a region. The Select a 

Region dialog does not appear when upgrading 

InScribe and logging in for the first time, nor does it 

appear if you do a basic uninstall and reinstall 

InScribe. 

Selecting the correct region ensures you are 

connected to the correct server. 

Note: This region can be changed at any given time on the login screen if needed. However, the need to change an 

application region is very rare and should only be done when instructed to do so. If you do not see the region you need in 

any application, please contact Support. 

Login Window 

After selecting a region (if applicable), the “eScription One InScribe” login 

window opens. The following options appear at the bottom of the window: 

– Download Dictations on sign in: Enable this option to download 

dictations automatically on login. 

– Sign in with Training Mode: Log into Training Mode to access the 

training files.  

Note: To see the ‘Sign in with Training Mode’ option, you must select 

‘View Training Materials’ during installation and download the InScribe 

training files, or you can download them from the software site: 

https://www.escription-one.com/Software/InScribe. 

– Change Region: Change the region associated with the user’s 

location. See also Select a Region. 

  

https://www.escription-one.com/Software/InScribe
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Initial Login 

To log in for the first time, click the New Login button at the bottom of the 

login window. 

The credentials screen opens. 

Enter your Username, Password, and Company, then click Log In.  

– Username:  Login credential to identify a transcriptionist.  

– Password:  Authenticating word or passphrase for secure login.  

– Company:  Abbreviation or Acronym identifying the transcription 

company. 

The Forgot Password? link allows users who have saved a valid email 

address to receive password reset instructions by email if it is lost or 

forgotten. For more information, go to Email Verification and Resetting 

your Password. 

Note: If multi-factor authentication (MFA) has been enabled for your company, please see ‘Setting Up Multi-Factor 

Authentication’. 

 

 

Logging in after the First Time 

The next time you log in, your saved login credentials appear 

on the login screen, along with the date and time of your last 

login. Your saved credentials include your Username and 

Company name. InScribe does not save passwords. 

 

 

 

 

 

Click the saved credentials icon. 
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The login screen opens, with the credentials filled in. Just enter 

your password and click Log In. 

Note: The pre-filled fields are read-only. To log in with a 

different Username and/or Company, click Cancel to return to 

the login screen and choose New Login. 

InScribe saves each set of credentials you use to log in. The 

most recent login appears at the top of the list.  

If you want to remove a saved login from the screen, for 

example, if you are a manager or if you perform 

QA, and you will not need to log into this account 

again, click the stop sign icon. The credentials will 

be removed from the screen. 
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Setting Up Multi-Factor Authentication Using Auth0 Guardian  

Multi-factor authentication is another way to verify a user’s identity, adding an extra level of security to the current login 

process. If your company has enabled multi-factor authentication, there will be a one-time procedure that requires you to 

download an authentication application called Auth0 Guardian onto your cell phone and create an account. Subsequently, 

when logging in, you will only need to accept a notification sent to your phone. This one-time procedure does not need to 

be repeated for each transcription app. If you have set it up for InScribe, you do not need to set it up again for 

InCommand. 

When logging in for the first time after multi-factor 

authentication has been enabled, you will enter your login 

credentials as usual. Before the application opens, the ‘Secure 

Your Account’ screen appears. Here you begin the one-time 

multi-factor authentication setup. 

Step 1: Download the Auth0 Guardian app 
Auth0 Guardian is a free security app for performing multi-

factor authentication. With the Guardian app, a notification is 

sent directly to your cell phone. There are no codes to 

manually enter; just press ‘Allow’ to accept the notification. 

If you do not have the Auth0 Guardian app already installed on 

your phone, you must first download it from the Apple store (for 

iPhone) or Google Play (for Android). Choose the appropriate 

button to view the location of the app’s download site. Search 

‘Auth0 Guardian’ and download it to your phone.  

 

Once you have the authentication app downloaded, open it. In your InScribe app, click Continue on the ‘Secure Your 

Account’ screen.  

Note: Other authentication apps may work as well but are not officially supported. 
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Step 2: Scan the Activation (QR) code 
Next, use the authentication app to scan the activation code that appears in InScribe by holding your phone up to the 

code. This will link the authentication app to your InScribe application.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the scanner does not automatically open, you may need to click the plus button at the top of the Guardian screen to add 

a new account.  

 

 

  



 

 

  

12 
eScription One February 2024 

 

© 2024 DeliverHealth. All rights reserved. 

Step 3: Copy the Recovery Code 
After scanning the QR code, you will receive a recovery code (in 

InScribe). If you need to log in and do not have your device, you 

can paste or enter this code to access InScribe. Copy the code 

and keep it somewhere safe.  

Click the check box indicating that you have recorded the code, 

then click Continue. 

You now have an account to which a notification request will be 

sent each time you log in. The email on your account will be the 

email listed for you on the Transcription Information or User 

Information screen in InCommand.  

InScribe will now open. 

Note: Remember to have your phone nearby when you log in 

from now on. See the next section for details. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



 

 

  

13 
eScription One February 2024 

 

© 2024 DeliverHealth. All rights reserved. 

Logging in with Multi-Factor Authentication 
Once you have completed the initial MFA setup process above, you will subsequently log in to InScribe as shown in the 

steps below. 

1. Open the Guardian app. 

2. In InScribe, enter your login credentials. 

The Verify Your Identity screen opens, indicating that a notification has been sent to your phone and is awaiting 

confirmation. 

3. In the Guardian app, click Allow.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After successful authentication, you will automatically be logged into InScribe.  

If you do not receive the notification, you can choose to have the notification resent, or you can manually enter the code at 

the bottom of the Guardian app (see below).   



 

 

  

14 
eScription One February 2024 

 

© 2024 DeliverHealth. All rights reserved. 

If you do not receive a notification, you can choose Manually Enter 

Code. 

 

 

 

 

 

 

 

 

 

 

Enter the code appearing at the bottom of the Guardian app.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Continue. After successful authentication, you will automatically be logged into InScribe. 

Note: If for some reason you cannot log in with MFA after having done so previously, please contact your manager to 

have it reset. 
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Email Verification 

If you do not have an email address on file, InScribe will prompt you to enter one when you log in. After doing so, a 

notification appears, indicating that a confirmation email has been sent to the email address entered. (You can choose not 

to enter an email, but will be prompted again on your next login.) 

 

Click on the link in the confirmation email to complete the verification process. 

To edit the user email address, go to File menu> Options> General> Account Options> Modify Account. If the email 

address has previously been verified and is then edited, you will be prompted to verify the updated email address. 

Resetting your Password 

If you have forgotten your password, you can reset it using the steps below.  

1. On the login screen, enter your Username and Company, then click Forgot 

Password?. 

 

 

2. On the ‘Forgot Password’ screen, click either the Send Email button or ‘Have 

reset code?’ link (if you already have a reset code). 
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3. If you choose Send Email, you must have a verified email address (see above). If so, an email will be sent to you 

with instructions and a link for resetting your password. Once you click the link, the ‘Reset Password’ screen appears 

with the reset code filled in. Enter the remaining information, then click the Reset Password button. 

 

If you choose ‘Have reset code?, the ‘Reset Password’ screen appears without 

the reset code filled in. Enter the code and remaining information, then click the 

Reset Password button.  

If you selected ‘Send Email’, you can also copy and paste the code from the 

email and paste it here. 
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Main InScribe Screen 

Once you successfully log in, the initial InScribe screen opens:  

 

Download Dictations 

Downloading Dictations:  At login, a request for dictations is made to the eScription One Server. This option can be 

disabled by unchecking the option “Get Dictations on Login” on the login screen or in File > Options > General > Startup 

Options. If this option is disabled, press “Next” (Hotkey: F12) to start downloading jobs. A status bar tracks the download 

process in the bottom left hand corner. Once the first file has been completely downloaded, transcription work can be 

started, with future downloads occurring in the background. 

Downloaded dictations appear at the top of the screen. By default, the maximum number of dictations is three. 
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Function Keys 

Function Key:  Downloading a transcription will enable the Function keys located at the top of InScribe. You can 

customize the function key actions if necessary (File > Options> Shortcut Keys).  

The options below are the defaults and are the most commonly used functions. 

 

 

< F1 > Next Field: Skip to the Next [Field] within the transcription. 

< F2 > Play:  Play and Pause the dictation playback. 

< F3 > Rewind: Rewinds the dictation playback. 

< F4 > Fast Forward: Fast Forward the dictation playback. 

< F5 > Add Associate:  Add a carbon copy recipient. 

< F6 > Copy Transcription:  Copy the Dictation Audio, Info Pane Demographics, Carbon Copies, Additional 

Authenticators, and the Transcription text of the selected Dictation to a new Transcription. 

< F7 > Complete:  Mark the selected transcription as “Done” or “Completed”. 

< F8 > Mark for Review:  Mark the selected transcription as "Marked for Review." 

< F9 > Save:  Save the selected transcription. 

< F10 > AutoText:   Create macros and text expansions. 

< F11 > Show Pool: Display work currently available for transcription. 

< F12 > Download Next:  Advance to the next dictation, download new files if available, and upload completed work. 
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Patient Demographics 

Info tab:  Patient demographic information is located in the Info tab within the 

demographics panel on the left side of the InScribe screen. Depending on the 

dictation device used by the author, demographic information may auto-populate 

when downloading the audio file. When demographic information is not 

automatically available, a Patient ID and/or Patient Name can be entered in the 

respective fields. After entering data in the Patient ID or Patient Name field, press 

“Tab” to perform a patient search based on that data. The Patient Name search will 

match on the entire name or any part of the patient’s name.  

If appointment information isn’t available, information can be entered manually. 

If the patient has multiple appointments, the “Appointment Listing” window will 

appear. Choose the appropriate appointment for the dictation, based on the 

dictating physician and the date. Use the arrow keys and press “Enter” to select the 

appointment. 

 

Info Tab Functions 

Along the top of the Info tab are function buttons to allow for quick access to commonly used demographic functions. 

– Patient Name Search:  Click the “Patient Name Search” icon (Hotkey: 

Ctrl+F) to search for patients by name and/or additional fields. 

The searchable fields and search results fields may change depending on 

the document type selected. The search function can search for partial 

names. For example, searching for “and” in the last name field will return 

results for “Anderson” and “Sanderson”. 

 

 

 

 

 

– Patient ID Search:  Search the patient database by ID for available Appointments.  (Hotkey: Ctrl+N) 

– Appointment Search:  Search the patient database for available appointments based on the Patient ID in the 

demographics. 
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– Clinician Appointment Listing:  Search for all appointments by Clinician and Appointment Date based on the 

Appointment Date and Clinician selected in the demographics.  (Hotkey: Ctrl+Shift+L) 

– Edit Patient:  Edit patient Demographic and Contact information.  (Hotkey: Ctrl+Alt+E) 

– List Document Types by Description:  Toggle between the short name and the long description in the Document 

Type drop-down list.  (Hotkey: Ctrl+Alt+X) 

Print and Document Template Demographics 

Choosing the correct Clinician, Document Type, and Location are critical to generating a properly formatted document.  

These three demographics determine which template is loaded. The print template, which includes any headers, footers, 

and letterhead, will automatically update when a new combination of Clinician, Document Type, and Location is selected.  

The finished document is built by combining the print template with the document template and transcribed text.  

If the clinician, document type, and/or location change after the document template has been loaded, InScribe users will 

need to decide what to do with the existing transcription in the main editing window. If the new combination has no 

document template associated with it, the existing transcription will remain. 

– Overwrite Transcription:  Delete all existing document 

template and any existing transcription. Any existing text will 

be replaced by the new Document template. 

– Insert at Cursor:  Insert the new document template at the 

location of the cursor. 

– Keep Text:  Keep the existing transcription without loading the 

new Document Template. 

 

 

Clinician 

Select from a list of possible dictators. The clinician field typically is populated 

with the dictators when a file is loaded into InScribe, but can be changed.  

(Hotkey: Alt+R) 

 

Document Types 

Choose from a list of possible document types available for the author. The 

author selects a document type during the dictation process. If an author 

selects the wrong document type or does not choose one, a new document 

type can be selected from the list. The list of available document types will 

change based on the author. Once a document type is selected, a Document 

Template will automatically load into the body of the transcription based on the 

combination of Author, Document Type, and Location.  (Hotkey: Alt+W) 
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Location 

The location demographic can be used to specify a specific physical location 

(South Clinic) or a department or organizational division (Cardiology 

Department). Most dictation methods allow or require the clinician to select a 

location.  (Hotkey: Alt+L) 

 

 

 

 

Carbon Copies 

– Add CC:  When an author needs to send a copy of the transcription to another person, 

the recipients are called Associates and are added in the CCs panel. To search for an 

associate, press “Add Associate” at the top of the screen or click the green .  

(Hotkey: F5 or Ctrl+Alt+N) 

To initiate a search, some or all of either the Associate’s first or last name must be 

entered. Additional information in the form of specialty, City, State, and Zip Code is 

optional. If you have a BenchMark KB subscription, you will also be able to search the 

national physician’s database. Click for more information: 

http://www.interfix.biz/kbemdat.aspx 

Press enter, the Search button, or use Alt+S to perform the search. 

Double-click a name from the results to open the Associate Details window.   

  

o Primary Associate:  One Primary associate is allowed per Transcription. 

This is the associate the document will be primarily addressed to. It is 

possible to have a document without a primary associate. 

o Add Associate:  Add the new Associate to the database or update an 

existing associate’s information. This option must be enabled by the 

Transcription Company. 

o AutoFax:  AutoFax status can only be changed if the Add Associate box is 

checked. When AutoFax is active, the associate will receive a fax via the 

eScription One AutoFax feature.  A valid 10-digit fax number must also be 

present. 

o PCP for Patient:  Add an associate as the Primary Care Provider. The 

Primary Care Provider is automatically copied on any future transcriptions 

for the same patient.  

http://www.interfix.biz/kbemdat.aspx
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– Delete CC:  Remove the selected associate from the CC list.  (Hotkey: Ctrl+D)  

– Edit CC:  Open the Associate Details window for the selected associate.  

(Hotkey: Ctrl+E)  

– Insert To Whom It May Concern Associate:  Insert a generic “To Whom It May 

Concern” as the addressee.  

– Make the Selected Associate the Primary Associate: Promote the selected associate to the status of the Primary 

Associate.  (Hotkey Ctrl+1) 

– Create Associate from Patient:  Convert the Patient’s information into an associate entry.  (Hotkey Ctrl+2) 

Additional Authenticators 

Additional Authenticators are added when a document requires more than one physician’s signature on the document.  

This frequently occurs when resident physicians are being overseen by attending physicians, but additional authenticators 

are added in a variety of situations. The drop-down list contains all the available dictating users for the Client. 

– To add an additional authenticator, open the drop-down menu, then select a provider’s name. (Hotkey Ctrl+Alt+A) 
You can also use the shortcut to put the focus in the drop-down menu, then scroll with the arrow keys and press enter 

(or use the shortcut again) to select. 

– To remove an additional authenticator, select the provider’s name from the list and press the  button.  (Hotkey 

Ctrl+Alt+D) 

– Use the  and  buttons to change the order in which the authenticators sign the document and the order in which the 

signatures appear on the transcription. 

Comments and Comment Tags 

Comments and Comment Tags are used to communicate information that does not appear on the document itself.  

Comment Tags are canned responses to frequently occurring issues. Healthcare providers researching documents can 

search and sort by comment tags in the InQuiry application. Comments are used to communicate with either QA 

personnel or with the healthcare providers. The transcription manager will have specific instructions on how to use the 

Comment and Comment tag features. 

– To add a comment tag, open the drop-down and select a comment from the list, or arrow down and press enter.  

– To remove a comment tag, select an existing comment tag and press the  button.  (Hotkey:  Alt+] ) 

– To add comments, enter text in the available space. The comments box supports cut, copy, and paste shortcuts.  

(Hotkey: Alt+[ ) 

– Press the  button to erase all comment content. 

– Press the  button to display available discrete data. 

Discrete Data 

Some document templates define fields that are specifically named by your transcription 

company. This allows the text used to replace that field to be referenced by a field later in 

the document or by an interface. The Discrete Data window allows you to see what fields 

have been identified and named, and what values have been associated with each field. 

Please note that this feature is rarely used.   
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File Tab 

The File menu contains Options and Administrative options. 

– Save:  Saves the contents of the Active Transcription. This performs the same function as 

the  button in the top left corner.  (Hotkey: Ctrl+S) 

– Stop Downloads:  Stops the automatic download of new dictations. The status of downloads 

is available in the top left corner.  (Hotkey: Ctrl+Alt+Z) 

o  Indicates dictations have not been blocked from downloading. 

o  Indicates dictations have been blocked from downloading. 

– Preview Transcription:  View the document as it would appear in InQuiry.  

o  Show/Hide Labels under the function buttons.  

o  Generates a Print Preview as if the document was printed. 

o  Refreshes the window to display any changes made. Alterations can be made in 

InScribe while the preview window is open. 

o  Closes the Transcription Viewer. 

 

– Explore:  Explore the contents of the folders where the raw 

dictation and transcription files are stored. The contents of this 

folder are primarily viewed when troubleshooting. 

– Backup Personal Files:  Create a backup of AutoText entries 

and words that have been added to the personal dictionary. The 

backup is placed in the InScribe folder of the computer’s 

Documents. 

– Restore Personal Files:  Restore AutoText and Personal 

dictionary entries from the backup location. 

– Options:  Customize InScribe behaviors and settings.  (See Options for additional information.) 

– Exit:  Exit and log out from the InScribe application.  
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Home Tab 

The Home tab contains the customizable function keys (see Function Keys) and the dictation playback controls.  

 

Dictation Playback 

The controls for dictation playback are located to the right of the F12 key on the Home tab.  

They include: 

4. Restart Dictation (Hotkey: Ctrl+Shift+Z) 

5. Rewind  (Hotkey: Ctrl+Shift+C) 

6. Play  (Hotkey: Ctrl+Shift+X) 

7. Pause  (Hotkey: Ctrl+Shift+Q) 

8. Fast-Forward  (Hotkey: Ctrl+Shift+V) 

9. Mark Index  (Hotkey: Ctrl+Shift+I) 

10. Jump to Index  (Hotkey: Ctrl+Shift+J) 

11. Clear Index  (Hotkey: Ctrl+Shift+K) 

12. Insert Time  (Hotkey: Ctrl+Alt+T) 

Speed and Playback Rate 

The Speed Control next to the playback controls is a drop-down menu. You can adjust the rate of 

dictation three different ways: 

– Click on Increase Speed to increase the speed to the next higher percentage of total speed 

rate, or click Decrease Speed to decrease the speed to the next lower percentage of total 

speed rate.  

– Use keyboard shortcuts (Hotkey Increase: Ctrl+Shift+. ) and (Hotkey Decrease: 

Ctrl+Shift+, ) 

– Click directly on the speed percentage.  

To remember the playback rate by author, go into the File tab> Options> Playback and select this 

option. 
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Volume Control 

The Volume Control is a drop-down menu below the speed control. In InScribe, you can adjust the 

volume three different ways: 

– Click on Louder to increase the volume to the next higher percentage of total volume, or click Softer 

to decrease the volume to the next lower percentage of total volume .  

– Use the keyboard shortcuts (Hotkey Louder: Ctrl+Shift+9) and (Hotkey Softer: Ctrl+Shift+8) 

– Click directly on the volume percentage. 

Volume can also be adjusted with the Windows Volume settings. 

ShadowScribe Cursor Functions 

These cursor features are only available during ShadowScribe or Voice Recognition jobs that have 

passed through the ASR engine for initial transcription. 

– Attach Selection:  Attach the Selection cursor to the Playback cursor.  (Hotkey: 

Ctrl+F12) 

– Move Playback to Cursor:  Adjust the playback time to match the cursor’s location in the 

Transcription.  (Hotkey: Ctrl+Shift+F12) 

Correction Playback 

Toggles between the retrieved dictation and the correction dictation when the “Retrieve & Correct” feature is used from 

Get Prior Transcriptions.  (Hotkey: Ctrl+Shift+R) 

Skip Silences 

A feature called ‘Skip Silences’ can be used to skip silences 

detected in ShadowScribe (also known as ASR, VR, or voice 

recognition) dictations. This feature will only work with dictations 

that have been submitted to ASR and have a draft returned.  

Enabling Skip Silences 

To enable the Skip Silences feature, the audio player in InScribe 

needs to be changed. To do this, go to File, then Options, then 

Advanced. In the Playback section, change Audio Player to 

Advanced. 

Press OK to close the Options window. 

In the Dictation Controls section, you will now see a Skip Silences 

button. Click to toggle the feature on (the button will be orange) or 

off. The button will appear disabled if a non-ShadowScribe job is 

loaded. 

 

 

When enabled, the playback rate will increase during detected silences and resume the normal rate when the silence is 

over.   
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Transcription Tab 

The Transcription Tab contains options for Creating, Navigating, Marking, Spelling, and Completing a transcription. 

 

 

 

 

Create 

– New:  Create a Transcription or TID, without an audio file.  (Hotkey: Ctrl+Shift+N) 

– Copy:  Create a Transcription with some or all of the properties as the Active Dictation. 

o Copy Transcription:  Copy the Dictation Audio, Info Tab Demographics, Carbon Copies, 

Additional Authenticators, and the Transcription text of the selected Dictation to a new 

Transcription.  (Hotkey: Ctrl+Shift+Y)  

o Copy Dictation and Header:  Copy the Dictation Audio, Info Tab Demographics, Carbon 

Copies, and Additional Authenticators.   

o Copy Dictation:  Copy the Dictation Audio File only.  (Hotkey: Ctrl+Alt+Y) 

o Split Transcription:  Copy the Dictation Audio, Info Tab Demographics, and the 

Transcription text after the cursor to a new Transcription.  (Hotkey: Ctrl+Alt+S) 

Navigate 

– Download Next:  Advance to the next dictation already downloaded, download the next dictation file from the server if 

the maximum allowed number of downloaded jobs has not been reached (this is set by the transcription company 

manager), and upload completed work.  (Hotkey: F12 or Ctrl+Shift+Return) 

– Move Up/Down:  Move between available downloaded dictations and audio files.  (Hotkey Up: Ctrl+Alt+Up) and 

(Hotkey Down: Ctrl+Alt+Down) 

Marking 

– Mark for QA:  Mark the transcription to be routed to the next QA level when available.  (Hotkey: Ctrl+Q) 

– Mark for Review:  Mark the transcription to be routed to the Client Review folder when available.  (Hotkey: Ctrl+W) 

– Lock:  Lock the transcription file to prevent accidental modification or completion.  (Hotkey: Ctrl+Alt+K) 

Spelling 

– Spell Check:  Manually initiate the spell check process.  (Hotkey: Ctrl+K) 
The Check Spelling dialog includes an added option to “Skip” misspelled words, rather than “Ignore”, which allows the 

word to be checked again in subsequent spellchecks.  

o Enable Spell Check as You Type:  Check this box to activate real time spell checking. 

Completion 

– Complete:  Mark the Transcription as completed and ready to upload to the server.  (Hotkey: Ctrl+O) 
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– Repool:  Check the Transcription and audio file back into the server and save any changes made to Author, Document 

Type, and Location.  (Hotkey: Ctrl+H) 

– Invalidate:  Mark the Transcription as invalid.  Invalid Transcriptions are removed from the standard workflow.  

(Hotkey: Ctrl+J)  

– Upload:  Send all Transcriptions marked as complete to the server.  (Hotkey: Alt+U) 

Data Tab 

The Data Tab has function buttons used to acquire information stored on the database for use during the transcription 

process. 

 

Templates 

– Document:  Download the Document Template for this Author, 

Document Type, and Location combination.  (Hotkey: Ctrl+Shift+G) 
 

 

 

 

– Dictation:  Retrieve a list of Dictation Templates or Normals, available to 

be inserted at the cursor.  A preview of the dictation template appears to 

the right of the list, allowing you to view the template before selecting.  

(Hotkey: Ctrl+Alt+G) 

 

Fields 

– Next:  Jump to the next available [Field]. Fields are indicated by the 

square brackets and may or may not contain text.  (Hotkey: Ctrl+G) 

– Clear Remaining:  Delete any unfilled transcription [Fields].  (Hotkey: Ctrl+[ ) 

Search 

– Patient:  Open the Patient Database search window. 

o By Number  (Hotkey: Ctrl+N) 

o By Name  (Hotkey: Ctrl+F) 

– Appointment:  Open the Appointment search window. 

o By Patient  

o By Clinician  (Hotkey: Ctrl+Shift+L)  
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– Transcription: 

o Prior:  Search for existing transcriptions based on Patient, Clinician, Document Type, and/or Transcription ID. Click 

Refresh after selecting criteria.  (Hotkey: Shift+F1) 
After searching, you can: 

• View Prior Transcriptions with 

or without the Print Template. 

• Select multiple transcriptions 

to view and compare using 

the check boxes. A single 

window opens, displaying the 

transcriptions separated by a 

Transcription ID heading. 

• Use the Append to Prior 

button to append the active 

transcription to the prior 

transcription or Remove 

Append to sever such a 

connection.  

• Use Retrieve and Correct to 

open the dictation in the 

editor and make any 

changes.  

• Click the audio icon to 

listen to the dictation. 

Playback controls will appear 

at the bottom of the window. 

Audio shortcuts are 

supported. 

o Find Existing:  Search the local backup directory for existing transcriptions if InScribe crashes or if a TID is 

accidentally checked in or re-pooled. 

Insert 

– Clinician:  Search the Client for available Authors. (Hotkey: Ctrl+Shift+Space) 

– Associate:  Search for an associate to add to the document. (Hotkey: Ctrl+Alt+Space) 

When you click OK, a list of four 

different formats appears, such 

as FIRST LAST and PREFIX 

LAST. Click one to select and 

insert it into the document at 

the current position of the 

cursor. 
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– AutoText:  Open the AutoText editing window.  (Hotkey: F10 or Ctrl+Shift+T) 

– Problem List:  Insert the problem list, if available, at the cursor.  (Hotkey: Ctrl+Alt+I) 
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Edit 

– Patient:  Edit Patient Information  (Hotkey: Ctrl+Alt+E) 

– Append/Unappend:  Append or Unappend this transcription to an existing transcription 

by TID number.  (Hotkey: Ctrl+Shift+A) 

– Problem List:  Open the Problem List editing window. This feature is infrequently used.  

(Hotkey: Ctrl+Alt+P) 

Lists 

– Commands:  View a list of available commands for various InScribe panes including 

Carbon Copies, Additional Authenticator, Comment Tags, Comments, and Discrete Data. 

 

 

 

ShadowScribe 

These options are only available when editing ShadowScribe or structured documents. 

Note: “Add Section” and “Add-Subsection” actions can be added to 

the Function Keys. 

– Add Section:  Add a new Section Heading after the currently 

selected section.  (Hotkey: Ctrl+Alt+H) 

– Add Sub-Section:  Add a new Sub-Section after the currently 

selected section.  (Hotkey: Ctrl+Alt+J) 

– Move Section Up:  Re-order the currently selected Section 

above the previous Section.  (Hotkey: Ctrl+Alt+, ) 

– Move Section and Sub-Sections Up:  Re-order the currently 

selected Section and all child Sub-Sections up above the 

previous Section.  (Hotkey: Alt+Shift+, ) 

– Move Section Down:  Re-order the currently selected Section 

below the following Section.  (Hotkey: Ctrl+Alt+.) 

– Move Section and Sub-Sections Down:  Re-order the currently 

selected Section and all child Sub-Sections below the following 

Section.  (Hotkey: Alt+Shift+.) 

– Delete Section:  Delete the selected Section heading. The contents of the deleted section will be added to the prior 

Section.  (Hotkey: Ctrl+Shift+\) 

– Delete Section and Contents:  Delete the selected Section heading and the entire contents of the deleted Section.  

(Hotkey: Ctrl+Alt+\) 

– Section Properties:  Edit the Title and Section Code.  (Hotkey: Ctrl+F6) 

– Make Sub-Section Section:  Promote a Sub-Section to Section status.  (Hotkey: Ctrl+,) 

– Make Section Sub-Section:  Demote a Section to Sub-Section status.  (Hotkey: Ctrl+.)  
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Format Tab and Editing Window 

The buttons available in the editing window are duplicated in the Format Tab for users who choose to hide the Editor bar 

(View tab> Editor). Those functions commonly associated with standard text editors are found on this tab and allow users 

to organize the document, add tables, lists, and other common document features. 

 

Transcription Functions 

Clipboard 

– Cut:  Copy the selected text to the clipboard, but remove it from the editing window.  (Hotkey: Ctrl+X) 

– Copy:  Copy the selected text to the clipboard and leave the text in the editing window.  (Hotkey: Ctrl+C) 

– Paste:  Paste selected text from the clipboard at the cursor in the editing window.  (Hotkey: Ctrl+V) 

– Undo:  Undo the last action taken or last text typed.  (Hotkey: Ctrl+Z) 

– Redo:  Retake the last action or replace text that was removed with the “Undo” function.  (Hotkey: Ctrl+Y) 

Editing 

– Find:  Search for keywords in the transcription text.  (Hotkey: Ctrl+Shift+F) 

– Replace:  Search for a keyword string and replace it with a different string of characters.  (Hotkey: Ctrl+Shift+H) 

– Remove Content After Cursor:  Delete all text after the cursor.  (Hotkey: Ctrl+Shift+Delete) 

– Select All:  Highlight all text in the transcription body.  (Hotkey: Ctrl+A) 

– Toggle Case:  Toggle text case between sentence case, upper case, and lower case.  (Hotkey: Ctrl+Alt+U) 

– Delete Left:  Delete the word to the left of the cursor.  (Hotkey: Ctrl+Backspace) 

– Delete Right:  Delete the word to the right of the cursor.  (Hotkey: Ctrl+Delete) 

– Go to Start:  Jump to top of report.  (Hotkey:  Ctrl+Alt+Home or Ctrl+Home) 

– Go to End:  Jump to bottom of report.  (Hotkey:  Ctrl+Alt+End or Ctrl+End) 

Text 

– Bold:  Begin transcribing text with Bold formatting or change selected text to bold.  (Hotkey: Ctrl+B) 

– Italic:  Begin transcribing text with Italic formatting or change selected text to italic.  (Hotkey: Ctrl+I) 

– Underline:  Begin transcribing text with Underlined formatting or change selected text to underline.  (Hotkey: Ctrl+U) 

– Remove Formatting:  Remove all formatting tags from selected text. 

– Strikethrough:  Begin transcribing text with Strikethrough formatting or change selected text to strikethrough. 
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– Superscript:  Begin transcribing text with superscript formatting or change selected text to superscript. 

– Subscript:  Begin transcribing text with subscript formatting or change selected text to subscript. 

– Open in Word:  Open the transcription in Microsoft Word (available for unstructured documents). 

Paragraph 

– Align Left:  Align transcription text to the left.  (Hotkey: Ctrl+Alt+L) 

– Align Center:  Align transcription text centered.  (Hotkey: Ctrl+Alt+C) 

– Align Right:  Align transcription text to the right.  (Hotkey: Ctrl+Alt+R) 

– Align Justified:  Align transcription text with both the left and right margins.  (Hotkey: Ctrl+Alt+F) 

– Unindent:  Unindent transcription text to the left.  (Hotkey: Ctrl+Shift+M) 

– Indent:  Indent transcription text to the right.   

– Insert Page Break:  Insert a manual page break (available for unstructured documents). 

– Show Glyphs:  Show formatting tags. 

Lists 

– Numbered List:  Toggle a numbered or ordered list (available for unstructured documents).  (Hotkey: Alt+Shift+V) 

– Bulleted List:  Toggle a bulleted or unordered list.  (Hotkey: Ctrl+Alt+V) 

– Horizontal Line:  Insert a page width horizontal line (available for unstructured documents). 

Table Functions 

– Insert 

o New Table:  Opens the table wizard and inserts the table with selected number of columns and rows at the cursor. 

o Insert Row Before:  Add a new row above the row the cursor is currently positioned in. 

o Insert Row After:  Add a new row below the row the cursor is currently positioned in.  (Hotkey: Alt+Shift+I) 

o Insert Column Before:  Insert a column to the left of the column the cursor is positioned in. 

o Insert Column After:  Insert a column to the right of the column the cursor is positioned in. 

o Insert Cell Before:  Insert a single cell to the left of the cursor position. 

o Insert Cell After:  Insert a single cell to the right of the cursor position. 

– Delete 

o Delete Table:  Delete the entire table and contents. 

o Delete Cell:  Delete the single cell the cursor is positioned in. 

o Delete Column:  Delete the column and contents the cursor is positioned in. 

o Delete Row:  Delete the row and contents the cursor is positioned in.  (Hotkey: Alt+Shift+D) 
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– Properties 

o Table Properties:  Access properties settings that affect the entire table. 

o Cell Properties:  Access properties settings that affect the cell the cursor is positioned in. 

– Merge: 

o Merge Cells:  Merge selected cells into one cell. 

o Merge Cell Right:  Merge the currently selected cell with the cell to the right. 

o Merge Cell Down:  Merge the currently selected cell with the cell below. 

– Split Cells:  Split the selected cell into two equal cells. 

 

View Menu 

Use the View menu to view information about transcription production and to change the appearance of InScribe. 

 

Dialogs 

– Log:  Display the log of completed transcriptions. The log is for informational use only. The actual line count may 

change based on transcriptions in QA, which will not be reflected in this log.  (Hotkey: Ctrl+L) 

o Log For:  Define the date range to 

search completed transcriptions.   

o Client:  Leave the client field blank 

to include all clients in the results or 

search for a specific client. 

o Date Type:  Search by Date 

Transcribed or Date Delivered. 

o Search:  Initiate the search using the 

selected parameters. 

o Include PHI:  Include confidential 

Patient Health Information on the 

report. 

o Save:  Save an electronic copy of 

the Transcription Log. 

o OK:  Close the transcription log. 
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– Work Pool:  Displays a list of transcriptions available for the MT currently logged in.    (Hotkey: Ctrl+Shift+P)  

o Transcription ID:  The unique job identifying 

number (TID). 

o Client:  The hospital or facility where the 

Transcription originated. 

o Clinician:  The author who dictated the job. 

o Doc Type:  The work type the dictation was 

created with. 

o Location:  The location the dictation was 

created with. 

o Priority:  The priority level assigned to the dictation.  Lower numbers indicate higher priority jobs.  By default, 

standard priority dictations are assigned a priority of 4 and STAT dictations are assigned a priority of 2. 

o Date Received:  The date the system received the dictation from the author. 

o Length:  The length of the dictation’s audio. 

o TAT:  Turnaround time is the total amount of time accumulated from when a dictation is received to when a 

transcription is delivered to InQuiry. 

o Receipt Code:  The dictation’s receipt code. 

– QA Feedback:  View Feedback for transcriptions reviewed in QA.  

(Hotkey: Ctrl+Alt+Q) 

– MT Notes:  View notes or instructions from the Transcription 

Company regarding the selected dictation. MT notes can include tips 

and information regarding the production of the transcriptions. This 

button will be disabled if MT Notes are not available for the selected 

job. 

MT notes are displayed before the appointment or order window 

appears, ensuring that you will always see any notes or instructions before making a visit selection. 

– Shortcuts:  View a list of all hotkeys available in 

InScribe.  

Type into the filter text box to quickly find the shortcut 

you’re looking for.Double-click a hotkey in the list to 

highlight it and make it a favorite. (Double-click again or 

click Reset to remove it as a favorite.) 

Click the ‘Only Show Favorites’ check box to see a list of 

your favorite shortcuts.  (Hotkey: Ctrl+Shift+S) 

– Character Map:  Open the character map for special 

characters.  
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– Count Lines:  Perform an ad hoc line count.  (Hotkey: Ctrl+T) 

– Configure Foot Pedal:  Configure a three button USB foot pedal for use with 

InScribe. Note that not all foot pedals are supported. 

– Dictation Details: View basic details of the dictation, such as Patient ID, 

appointment date/time, clinician, document type, etc. (Hotkey: Ctrl+Shift+?) 

– Original Demographics:  View the original patient demographics before edits were made by the current MT. This will 

open a separate viewer window to compare the data to the demographics panel. 

Toolbars 

– Show/Hide Toolbars:  Toolbars highlighted in orange will be displayed in the InScribe editor window.  Click to de-

select the toolbars to hide them. 

o Editor:  This toolbar contains the editing functions that are available in the Format Tab. 

o Demographics:  This toolbar contains functions to search for patient demographics. 

o Ratings:  This toolbar is used when creating QA feedback. 

o Lists:  These toolbars control Associate, Additional Authenticators, Comment Tags, and Comment functions. 

o Status Bar:  Displays MT Pool and Feedback counts and InScribe activity statuses. 

o Ribbon Shortcuts:  Displays the shortcut with the function title for any ribbon item that has an assigned hotkey.  

 

Panels 

– Reset Sizes:  Resizes all panels to their default size and position in InScribe. 

– Maximize Editor:  Hide the Demographics info, list of downloaded dictations, Associates, Additional Authenticator, and 

Comment panes to enlarge the viewable area of the Transcription Editor.  (Hotkey: Ctrl+Tab) 

– Comment:  Click to display the comments list. 

– Discrete Data:  Click to display the Discrete Data list.  Some document templates define fields that are specifically 

named by your transcription company. This allows the text used to replace that field to be referenced by a field later in 

the document or by an interface. The Discrete Data window allows you to see what fields have been identified and 

named, and what values have been associated with each field. Please note that this feature is rarely used. 

Note: ‘Comment’ and ‘Discrete Data’ cannot both be selected at the same time. 
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Zoom Settings 

Zoom allows the apparent size of the text to be adjusted for visibility without altering the actual text size on 

the finished document.  Select the desired zoom setting from the drop-down menu or use the Zoom In and 

Zoom Out buttons to select incrementally. 

– :  Increase the apparent size of the text. 

– :  Decrease the apparent size of the text. 

 

Jump Functions 

Use the Jump Function to quickly navigate to different Panes in InScribe.  (Hotkey: Alt+J) Once the Jump 

process is enabled, InScribe will prompt with letter keys until the cursor is in the desired position. 
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Advanced Table Functions 

Advanced Table functions allow for control over the size and appearance of a table. 

Table Properties 

Table Properties affect the size and appearance of the entire table. To access the table 

properties, place the cursor in any cell belonging to the table and press the table properties 

button. Table properties contains four tabs: Table, Row, Column, and Cell.  

Table Tab: 

– Width:  The width of the page the table occupies, measured in pixels or 

percentage. 

– Alignment:  The alignment of the table on the page. Options are Left, 

Right, and Center with an additional option to indent.  

– Default Cell Padding:  The amount of space between the text and the cell 

walls. 

– Default Cell Spacing:  The amount of space between individual cells. 

– Table Direction: The direction the cursor moves through the table. Options 

are left-to-right (default) and right-to-left.  

 

 

Row Tab:  

– Size: The height of each row.  

– Options: Repeat as header row at the top of each page.  

– Previous/Next Row Buttons: Move backward/forward through rows. 
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Column Tab:  

– Size: The width of each column. 

– Previous/Next Column Buttons: Move backward/forward through 

columns.  

 

Cell Tab: Explained below under Cell Properties.  

 

 

 

 

 

Table Border Properties 

Border properties allow you to customize borders and contains two tabs: Table 

Borders and Cell Borders.  To access the border properties, place the cursor in the 

cell and press the table border properties button. 

Table Borders Tab: 

– Setting: The position of the table border. You can also click on 

the position pane on the right side of the dialog box. 

– Style: The type of table border.  

– Color:  The color of the table border. 

– Width:  The thickness of the table border.   

 

Cell Borders Tab:  

– Setting: The position of the cell border.  You can also click on 

the position pane on the right side of the dialog box.  

– Style: The type of cell border.  

– Color: The color of the cell border.  

– Width: The thickness of the cell border.  

 

Cell Properties 

Cell Properties affect the size and appearance of individual cells.  To access the cell properties, 

place the cursor in the cell and press the cell properties button. 
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– Background:  Color of the individual cell background. 

– Vertical Alignment:  The vertical alignment of the text inside the cell.  

Options are Top, Middle, and Bottom.  

– Text Alignment:  The horizontal alignment of the text inside the cell.  

Options are Left, Center, Right, and Justified.   

– Cell Padding:  The amount of space between the text and the cell walls. 

 

 

 

Options 

Select Options from the File Menu. The options change how InScribe behaves and allow the 

transcriptionist to customize the workspace to optimize production.  
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General 

General options for working in InScribe.  

– Startup Options 

o Download Dictations on Startup:  Deselecting this option will prevent InScribe from automatically requesting a 

dictation upon login. 

o Hide Available Upgrades:  InScribe will not prompt to update 

when an update is available. 

– Account Options 

o Change Password:  Change the password used to log into 

the current InScribe account.  

o Modify Account: Change the personal information 

associated with your account (name, email, phone number). 

– Benchmark KB 

o User Name:  The login ID assigned by Benchmark. 

o Password:  The password for the Benchmark ID. 

o Register with Benchmark KB:  A link for new Benchmark KB users. 

– Language:  Currently InScribe is supported in English and Swedish. 

Prompts 

Change how InScribe prompts and notifies you.  

– Job Completion 

o Prompt to Mark for QA:  Options are Always, When in Question, When in Question and Unmarked, and Never.  

▪ “When in Question” refers to jobs in which the patient name or transcription text contains unexpected characters  

• Patient Name: Asterisk, underscore, and question mark * _ ? 

• Transcription text: Asterisk, underscore, question mark and square brackets * _ ? [ ] 

o Prompt to Mark for QA when Comments or Comment Tags Exist:  Toggle to Mark for QA based upon Comments 

and Comment Tags. 

– Application Close 

o Show Shutdown Confirmation:  Enables a Shutdown Confirmation 

popup to prevent accidental log off. 

– Notifications 

o Prompt When High Priority Job Received:  Display a notification if a 

higher priority (STAT) dictation is downloaded to the queue. 
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o Prompt When Unselected Job is Removed from Your Pool:  Display a notification if a dictation is removed from 

your downloaded queue by the Transcription Manager or automatic check-in. 

o Prompt When Queue is Empty and New Work is Available:  Display a notification if no dictations are downloaded 

and work is added to the pool. 

o Prompt When Clinician Field Changes:  Display a notification if the Author field is updated. 

o Prompt When Appointment Date is After Dictation Date:  Display a notification if the Appointment date is later 

than the Dictation Date. 

o Prompt When Dictation Has Not Been Played Within [ ] Seconds:  Display a notification if the entire audio file has 

not been listened to. 

Playback 

Playback Options control how InScribe’s audio player performs. 

– Control Functions 

o Continue Playback After Rewind or Fast Forward:  Activate this option and the player will continue playback after 

performing Rewind and Fast Forward. Otherwise the player will pause. 

o Separate Play and Pause Functions:  Enable to prevent the play button, shortcut or F-key from pausing the 

dictation playback. 

o Remember Volume and Playback Rate by Clinician:  Enable to allow InScribe to automatically adjust Volume and 

Playback rate to the last used settings per Author. 

– Time Adjustments 

o Rewind [ ] Seconds: Control the increment that InScribe Rewinds per button press. 

o Fast Forward [ ] Seconds:  Control the increment that InScribe Fast Forwards per button press. 

o Pause [ ] Seconds:  Control the increment that InScribe automatically Rewinds when the dictation playback is 

paused then resumed. 

– ShadowScribe Playback 

o Attach Voice Cursor on Play:  Attach the Editing Cursor to the Voice Cursor when the dictation is played. 

o Attach Voice Cursor on Rewind and Fast Forward:  Attach the Editing Cursor to the Voice Cursor after Fast 

Forward and Rewind actions are performed. 

o Attach Voice Cursor on Jump to Index:  Attach Editing Cursor to the Voice Cursor after Jump to Index action is 

performed. 

o Change Voice Cursor Color:  Change the Color of the Voice Cursor to suit user preference. 

Editing 

– Auto Saving 
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o Automatically Save Job Every [ ] minutes:  Control the frequency that InScribe will create a save file for the 

selected transcription.  Increase the time to increase computer performance. Decrease time to perform a greater 

number of backups. 

– User Interface 

o Demographics Highlighter Color:  Change the color of the label text in the Info Tab. 

o List Document Types by Description:  Enable to list Document Types by their descriptions instead of their names. 

o Resize List Panels on Focus:  Reset the size of List Panels to their default. 

o Hide Pool Count:  Hide the number of Dictations in the Transcription Pool displayed in the status bar at the bottom 

of InScribe. 

o Use Orders Tab: Enable to display a separate Orders tab in the demographics pane.  

– Patient and Appointment Options 

o Search for Appointment/Orders When Dictation Loads at Transcription Level:  Automatically search for an 

appointment if patient information is attached to the dictation when it is loaded at the standard transcription level. 

o Search for Appointment/Orders When Dictation Loads at QA levels:  Automatically search for an appointment if 

patient information is attached to the dictation when it is loaded at any QA level. 

o Show Single Patient When Not an Exact Match:  Show a patient listing when the result is a single patient, but is 

not an exact match.  Otherwise, the patient information will automatically import. 

o Show Single Appointment/Order:  Show the Appointment Search window even if only one appointment option is 

available for the patient.  Otherwise, the appointment information will automatically import. 

o Automatically Load the First Appointment:  Automatically load the most recent appointment, prior to or equal to 

today’s date, for the patient.  Otherwise, the Appointment Search window will display all available appointments. 

o Automatically Select Single Patient from Clinician Listing:  Automatically import patient information if only one 

patient is available for the Author for the selected appointment date. 

– AutoText 

o Automatically Expand AutoText:  Enable the use of the AutoText word expansion feature. 

o Jump to Next Bracket After AutoText:  Enable and InScribe will automatically jump to the next [field] in the 

document.  Otherwise use the Fields command to jump to the next field.  (Hotkey:  F1) 

o Start Bracket Search at the Beginning of the Document:  InScribe will begin searching for [fields] at the start of 

the document after the last [field] has been populated.  

o Show AutoText List in Comments:  Add a drop-down list to select from AutoText entries 

marked for use as a Canned Comment in the Comments list. 

o Use All AutoText as Canned Comments:  Enable to display all AutoText entries in the drop-

down list in Comments. 

o Use Double Space After Sentence:  InScribe will enforce two spaces after sentence punctuation. 
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– Templates 

o Get Document Template When the Location is Changed:  InScribe will prompt to 

load a new Document Template upon Location change. Note that if the transcription 

contains text you will be prompted to choose to overwrite the existing text with the new 

template text, insert the new template text at the cursor, or keep the existing 

transcription text without loading the new template text.   

o Process Bracketed Fields After Inserting Dictation Template: Allow InScribe to 

jump to first bracketed [field] in a dictation template after inserting. If “Automatically Fill 

Template Fields” is set as “Always,” InScribe will also automatically populate any [field] 

it has data for. 

o Automatically Fill Template Fields:  Allow InScribe to automatically populate any 

[field] that it has data for.  For example, if Date of Birth is entered into the Info tab, 

InScribe will automatically calculate the answer for the [Age] field or can populate the [Birthdate] data field within the 

transcription text. 

• Options are Always, Never, and Prompt. 

• On the right is a list of [Fields] that InScribe is capable of populating/calculating. 

Foot Pedals 

Foot Pedals are used by InScribe to control the Play, Pause, Fast 

Forward, and Rewind playback functions of the dictation, freeing up the 

typists’ hands from those tasks.  If InScribe is open and a foot pedal is 

plugged in, InScribe will prompt the user to configure the foot pedal.  

The foot pedal configuration screen can also be opened via the File 

Menu, then Options, then Foot Pedals.  

– Options:  

o Use Play/Pause Foot Pedal to Toggle Playback: Select this 

option to play audio by pressing and releasing the center pedal and 

to pause by pressing and releasing again.  

– Status:  The status window displays a list of all connected foot 

pedals.  A check in the box of the “configured” column indicates that 

the device has been configured and will work with InScribe. 

o Foot pedals that are un-plugged from the computer will be 

remembered and will not have to be reconfigured. 

– Foot Pedal Configuration Wizard:  Press to launch the Foot Pedal Configuration Wizard. 

 



 

 

  

44 
eScription One February 2024 

 

© 2024 DeliverHealth. All rights reserved. 

Configuration Wizard 

– Start the wizard by either plugging in a USB foot pedal, or by selecting the 

Configuration button. 

 

 

 

 

 

 

 

 

– Press and Release the Play Pedal. 

 

 

 

 

 

 

– Press and Release the Rewind Pedal. 

 

 

 

 

 

– Press and Release the Fast Forward Pedal. 
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– Configuration Complete. 

 

 

 

 

 

Spelling 

Control Spellcheck and Dictionary options. 

– Configuration 

o Check Spelling as You Type:  Allow InScribe to display the red line underneath misspelled words as you type. 

– Correction Options 

o Ignore Words in ALL CAPS 

o Ignore Domain Names (Web Addresses, etc.) 

o Ignore mIxeD CaSE 

o Ignore Words with Digits (Hello1) 

o Ignore Numbers (12345) 

o Ignore Capitalized Words (First Letter Caps) 

o Split Hyphenated Words for Spelling (auto-text) 

o Split Contracted Words for Spelling (couldn’t) 

o Allow Possessives on Words (patient’s) 

o Report Uncapitalized Words (canada) 

o Report Doubled Words (the the) 

o Report mIxeD CaSE Words 

o Report Words with Digits (Hello2) 

o Suggest Split Words (theboy = the boy) 

o Suggest Phonetic Words 

o Suggest Typographical Words 

o Case Sensitive (Treat canada and Canada differently) 

o Check Word Parts (dumptruckdriver would be correct) 
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o Capitalize First Letter of Sentence as You Type 

– Reset Options:  Reset spelling options back to default. 

– Dictionaries:  Press the Custom Dictionaries button to choose which dictionaries will be used.  Dictionaries on the right 

side of the Custom Dictionaries window are available for use. Dictionaries on the left side are currently active. 

o Compiled Dictionaries:  Pre-made dictionaries that include Standard English and British dictionaries, as well as 

medical dictionaries. Benchmark KB can also be enabled to include Stedman’s Medical Dictionary. See Options> 

General for more information.   

o User Dictionaries:  Dictionaries that contain words that are added by the user. 

Shortcut Keys 

– Action Keys:  Customize the actions performed by the Action Keys F1 through F12. 

o Reset Actions:  Reset the Action Keys to their default settings. 

– Options 

o Disable Shortcuts for Re-Pool and Invalidate:  Disable these two shortcuts to prevent accidental usage. 

o Shortcuts:  Choose the Shortcut configuration. 

• Use Modified Shortcuts:  This is the default option and has been optimized for InScribe version 7. This is also the 
shortcut set used in this manual. 

• Use Classic Shortcuts:  Use the original shortcuts from prior versions of the software. 

• Use ASR Enhanced Shortcuts:  Use a shortcut configuration optimized for use with ShadowScribe editing (Voice 
Recognition QA). 

o Export Shortcuts: Allows you to save a copy of the shortcuts to a name and location of your choice as an .xml file to 
edit/customize in Notepad++.  

o Import Shortcuts: Allows you to import the edited exported .xml file into InScribe. After successful import, “Use 
Custom Shortcuts” will be displayed in the shortcuts drop-down.   

Advanced 

– Shortcuts 

o Use Global Function Keys:  Allow the Action Keys (F1 through F12) and other (Hotkeys) to be active even when 

InScribe is not the primary active program in Microsoft Windows. 

– Prompts 

o Automatically Check for New Dictations Every [ ] Minutes:  Enable InScribe to check for available dictations at 

the specified interval. 

o Display JavaScript Errors:  For troubleshooting purposes, display error message for InScribe. 

– Foot Pedals  

o Foot Pedals Remain Active While Other Applications are Active:  Allow the InScribe audio to be accessed with 

the foot pedals even when InScribe is not the primary active program in Microsoft Windows.  
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– Playback 

o Audio Player 

• InScribe:  Use the default InScribe player. 

• Advanced: Boosts dictation playback volume by 100% and allows silences to be skipped (adding a button to the 
Dictation Controls ribbon menu).  

o InScribe Wave Player:   

• Automatic – the default wave player for InScribe (WASAPI). 

• WASAPI – the default wave player for InScribe. 

• WaveOut – an alternate wave player option if dictation playback is troublesome. 

– Field Behavior 

o Use Alternate Timestamp Format: This option will insert timestamp in milliseconds. 

– Data 

o Remove Save Folders:  This option will remove all prior “Save” folders under this username.  By default, InScribe 

removes old folders each time you log in, but saves the last two weeks of transcription data.  This option will clear all 

old data. 

o Backup and Restore Personal Files 

• Backup to Set:  Choose the Backup options to save your AutoText and User Dictionary to a copied location on 
your computer, which you can use to switch between sets or simply have a backup copy.  

• Restore from Set:  Restore a previous backup of your AutoText and User 
Dictionary files. 

• Backup to Location:  Options to specify where you want to save a backup of your 
AutoText and User Dictionary, which you can use to keep a backup on a separate 
disk or to move to another computer. 

• Restore from Location:  Options to retrieve a prior backup of your AutoText and 
User Dictionary files. 

o Get Recalled Jobs: If one of your jobs has been checked back in (by an automatic 
process or manually by a manager) and becomes available in your queue again, you 
may press this button to download the typed work you completed prior to it being 
recalled. 
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AutoText 

AutoText is InScribe’s built in Word Expander. It is located on the Data tab (or by pressing 

<F10>). Word expansion can be as simple as expanding a few characters into a longer word or 

phrase, or as much as entire templates complete with Tables and Ordered Lists.  All of the 

formatting options that are available in the standard editing window are available in the 

AutoText editing window.  

Adding and Removing Entries 

On the left side of the AutoText window is a list of all current expansions. 

– The green  button creates a new entry.  The name entered here will be the short version 

of the expansion. Note that InScribe will gray out the “OK” button if the name entered has 

invalid characters or is already in use. 

 

– The  Save button stores changes made to the selected entry. 

 

– The  Delete button removes the selected AutoText entry.  Deleted entries can be 

recovered from backup files. 

 

– The Find box is a keyword search and will return results for the short 

name field. The  button initiates a search and the  clears the 

contents of the search box. 

 

 

Quick Add Feature 

Use the Quick Add boxes to quickly add new AutoText entries. Enter the short form on the left and the long form on the 

right. Press the  button or enter to add and save the entry. This feature is ideal for quickly adding short expansions, but 

is not suited for large amounts of text and advanced formatting such as tables and lists. 
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AutoText Editing  

All of the formatting functions available in the standard editing window are 

available in the AutoText editing window. A detailed explanation of these 

functions is available in the Format Tab and Editing Window section. In addition 

to the standard formatting options, there are two radial menu options: 

– Use as AutoText:  This entry is used in the main editing window. 

– Use as Canned Comment:  This entry is used in the comments pane, but can 

also be used in the editing window. 

It is possible under the Options Editing section to allow standard AutoText entries 

in the Comments section. 

Fields and Functions 

Fields and Functions found in your AutoText creator are advanced template creating functions. Using Fields and 

Functions are comprehensively covered in a document found here: https://www.escription-one.com/Software/InScribe 

Click here to download: How to use Template Fields and Functions. 

  

https://www.escription-one.com/Software/InScribe
https://www.escription-one.com/Software/Download?fileName=Template%2520Fields%2520Use%2520Guide%252020170608.1.docx
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Rating a Transcription in InScribe 

QA Ratings & Feedback allows the QA staff to record errors and leave feedback for the prior MT while editing the 

transcription. Each time a transcription passes through QA, the QA staff is able to rate the quality of the previous 

transcriptionist. The ratings and comments applied by a QA1 staff member will be visible to the original Transcriptionist; 

the ratings and comments applied by a QA2 staff member will be visible to the QA1 who worked on this document, and so 

on. 

Your Transcription Company can determine if these ratings will affect your overall Quality Score, and thus your pay rate 

for this transcription. Your company might also choose to utilize this feature to simply provide feedback on the quality of 

your work without influencing your pay rate. 

Rating Process 

If the QA Ratings & Feedback feature has been 

configured and enabled by the transcription 

company, the QA staff will see the Ratings tab in 

InScribe.  

The Ratings tab is in the Demographics panel. Click 

on the “Ratings” tab. (Hotkey: Ctrl+R) 

 

 

 

In the example, the word “work” is misspelled 

in the first sentence. The process to correct 

this and add an English Word Misspelling 

error is:  

1. In the Editor panel, delete “wrk” and 

type “work”.  Jump to the Ratings 

Tab. 

2. Press E to select English Word 

Misspelling. 

3. Press Enter to add an Error 

Identification marker. 

4. Press Enter to jump to the 

Comment area. 

5. Type your comment and press 

Enter to jump to the Editor panel. 

The cursor returns to the same 

location it was in before you added 

the error. 
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Notes: 

– Shortcut keys are assigned by transcription company management when creating the Rating Program.  

– The same shortcut key may be assigned to more than one Rating. In our example, W is the shortcut key for Medical 

Word Misuse in the Critical Category and for Medical Word Misuse in the Major Category.  

o Pressing W once moves to the first Rating.  

o Pressing W twice moves to the second Rating.  

o If W is pressed a third time, it moves back to the first Rating. 

– Comments are not required. After identifying a new error press Enter a second time to bypass the comment and return 

to the transcription body. 

– To correct the misspelling, place the cursor between “w” and “r” of “wrk” and type “o”. 

– Return to the Demographic panel by clicking on the Info tab at the bottom.  (Hotkey: Alt+I) 

– A time index is created to mark the dictation at the time the error was created. This index will be available for playback 

to the person who receives your feedback. 

Let QA Decide / Feedback Only 

The transcription company will determine whether or not the Ratings feature will 

influence the Quality Score, and thus change the pay rate of its transcriptionists. 

QA staff can be given the ability to make this decision on a per-transcription 

basis. At the bottom of the Ratings window is a checkbox for “Feedback only (not 

graded)” that is enabled depending on the company’s Ratings settings.  

– If Ratings will not influence the Quality Score, this option is turned ON, and QA 

cannot change the setting. This option will simply provide feedback to the 

person whose work you are reviewing. 

– If Ratings will influence the Quality Score, this option is turned OFF and QA 

cannot change the setting. 

– The company can also decide to allow the QA staff to enable this option. Doing so causes this transcription to be 

ignored by the Quality Score and will not affect the transcriptionist’s pay. By default, this checkbox is not selected when 

a document is sent to QA.  Select “Feedback only (not graded)” for minor changes that should not affect transcription 

pay rate. 

Reviewing Feedback 

When new feedback is available, a link will appear at the bottom of 

InScribe upon login.  Click the link to open the QA Feedback summary 

window.  Feedback is also accessed via the View Menu and pressing 

the button to view QA feedback.  (Hotkey: Ctrl+Alt+Q) 
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Navigating the Feedback List 

 

– Sort:  Click on any column title to sort feedback items by that column.  Click once to sort in ascending order, twice to 

sort in descending order. 

– Filter:  Use the drop-down menu boxes under any column header to filter feedback to show only transcriptions 

containing that value.  Use this feature to view a particular client, document type, etc. 

– Clear Filters Button :  Reset any selected filters to display any feedback items that might be hidden. 

– Complete Selected:  Remove feedback items by selecting the boxes on the left and clicking Complete Selected. 

– Complete All:  Remove all feedback items. 

– Complete:  Complete an individual feedback item using the “Complete” button in the 

Controls box. 

– Autocomplete Unmodified Feedback:  Turn on to skip feedback for transcriptions where 

the body has not been modified by QA (such as those that only go to QA to add an 

associate). 

Records with Bold text have not been reviewed and are considered “New.”  Records not in bold text have been previously 

opened. 

Transcription Feedback 

View a specific feedback item by clicking on the 

transcription record.  Feedback will open in the bottom 

of the window.  The transcription text section defaults 

to the “QA Version” Tab. 

Identified errors are placed in categories to the left.  

Expand the error categories to see individual errors. 

Click on the Dictation Position value in the Error 

Details to move the playback cursor to that time on the 

audio file. Additional playback controls allow for Play, 

Pause, Rewind, Fast Forward, Move to Beginning, and 

Move to End.  
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When a specific error code is selected, additional error details appear which include: 

– The type of error code identified. 

– The Category of the error code. 

– The time in the audio file that the error 

was identified. 

– Any additional comments about the error 

added by QA. 

If “Show Changes” is unchecked in the QA 

version tab, clicking on an individual error 

will also highlight in blue any altered text.  

Toggle between the QA finalized version 

and the changes mark-up version with the 

“Show Changes” checkbox. 

 

With “Show Changes” checked, the transcription is marked with QA alterations. 

– Deleted items are highlighted in pink. 

– Inserted items are highlighted in green.   

– Items with formatting changes are highlighted in blue. 

The original transcription text is available under the “My Version” tab. 

The “Client Version” tab displays edits made by the client. 



 

 

  

54 
eScription One February 2024 

 

© 2024 DeliverHealth. All rights reserved. 

Score Card 

A summary of all errors and point deductions is available on the Score Card.  The score card can be printed with the 

available print button. 

 

– Error:  All Error Categories and Error Codes used by the QA Program. 

– Errors Recorded:  The number of occurrences for the error in this transcription. 

– Points:  The number of points deducted for each occurrence of the error. 

– Deduction:  The number of points deducted for this error type in this transcription.  This is calculated by multiplying 

“Errors Recorded” by “Points.” 

The Final Score for the selected transcription is located at the bottom of the Score Card.  This is calculated based upon 

the number of points deducted against the number of lines in the transcription. 
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The Quick Access Toolbar 

The Quick Access Toolbar is located in the top left corner of the InScribe Window above the ribbon menus. By default, it 

has buttons to Save the transcription and to Stop Downloads. Toolbar options are found by right-clicking on any icon in 

the Ribbon Menu or on the Quick Access Toolbar itself. 

 

 

 

 

 

 

 

– Add to Quick Access Toolbar: This option is available when right-clicking on icons in the Ribbon menu. If the item is 

already present on the Toolbar, this option will be grayed out. This will add the selected action to the Toolbar. 

– Remove from Quick Access Toolbar:  This option is available when right-clicking on icons in the Toolbar. This will 

remove the selected action from the Toolbar. 

– Show Quick Access Toolbar above/below the 

Ribbon:  This option is available when right-

clicking on icons in the Ribbon menu or Toolbar. 

This will toggle where the Toolbar is displayed. 

– Minimize the Ribbon:  This option is available 

when right-clicking on icons in the Ribbon menu 

or Toolbar. This will hide the Ribbon Menu icons. 

 

Help Menu 

The help menu contains troubleshooting tools and links to articles that provide information to users experiencing difficulty 

or learning to use the program. 

– Press the  button to open up the InScribe software page. 

To access the following features first press the  next to the  button and make a 

selection. 

– InScribe website: Also opens the InScribe software page. 

– Knowledge Base:  Open the DeliverHealth Knowledge base for frequently asked 

questions and troubleshooting assistance. 
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– About:  Obtain statistics for InScribe and view the current transcription in HTML format.  If instructed by a technician, 

press the “click here” link to upload additional diagnostic data in the form of a support ticket. 

– Support:  Contact information to receive technical support. 

Spellchecker FAQ 

The suggestions that are shown in the Check Spelling dialog during spell check do not make sense. For example, 
when "accepted" was misspelled, the suggestion was "crepe"? 
If this occurs, try checking the “Suggest Phonetic Words” and/or “Suggest Typographical Words” options under File> 
Options> Spelling. 

I added a word to my User Dictionary and now it is not there. What do I do? 
View Words from the Spelling and Typing Options dialog does not list the added words in alphabetical order and may give 
the impression that the word is missing. If you don't want to scroll through the entire User Dictionary Word List, you can 
also open the userdic.tlx file with Notepad and use the Find function to verify that a given word is in the dictionary. To do 
this click on the Start button, select All Programs, select Accessories, then Notepad. With Notepad open, select the File 
menu, then Open. When the Open dialog displays, go to the File Types drop-down menu and select All Files (*.*), go to 
your AppData folder, then navigate to Roaming > Emdat > InScribe 6 > transcription.escription-one.com (or it may be 
different if you are not logged into the US region) > Dictionary; choose the userdic.tlx file. When the user dictionary opens, 
use Ctrl+F or click on the Edit menu and then Find to bring up the Find dialog and search for your word. 

The suggestions for hyphenated words have an extra space. For example, when "18-year-old" is flagged by spell 
check, the suggestion is "18- year- old"? 
This will occur when "Split Hyphenated Words for Spelling" is unchecked in the Spelling and Typing Options dialog. Check 
the box and suggestions will be provided based on each individual segment. 

Spell check is not flagging misspelled words. For example, when "Zocor" was misspelled as "Zocorr", it passed 
the spell check? 
This will occur when "Ignore Capitalized Words" is checked in the Spelling and Typing Options dialog. Remove the check 
box and incorrectly spelled capitalized words will be flagged. 

Spell check is not flagging misspelled words. For example, when "cabinet" was misspelled as "cabnet", it passed 
the spell check? 
This will occur when "Check Word Parts" is checked in the Spelling and Typing Options dialog. Remove the check box 
and spell check will look at the entire word instead of breaking it down into parts (i.e. “cab” and “net”). 

I upgraded InScribe and spell check is acting differently. Words which would have flagged before are not and 
words are flagging that didn't use to? 
Spell check has changed and is now looking at each word in context to its surrounding words. This provides for improved 
reliability and conforms more closely to spell check rules used by popular word processing programs such as Microsoft 
Word. 
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Removing InScribe 

Note: Users on a network may need to contact their system administrators if they do not have the rights to install or 

uninstall software. 

– Click on “Start” and select the ‘Settings” option.  

– On the Windows Setting screen select “Apps”. 

– Scroll down to “InScribe 7”. 

– Click the “Uninstall” button. 

–  Click “Uninstall” again to confirm. 
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Support 

Get assistance for InScribe and all other eScription One applications here: 

– Phone Support: 1-800-858-0080 

– Support Email: esone.support@DeliverHealth.com 

To access the eScription One software page for downloading InScribe, click here: https://www.escription-

one.com/Software/InScribe 
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